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ABSTRACT 

Recent studies have suggested that silver nanoparticles (AgNPs) may affect cell DNA 

structure in in vitro conditions. In this paper, we present the results indicating that AgNPs 

change nuclear complexity properties in isolated human epithelial buccal cells in a time-

dependent manner. Epithelial buccal cells were plated in special tissue culture chamber / 

slides and were kept at 37 0C in an RPMI 1640 cell culture medium supplemented with L-

glutamine. The cells were treated with colloidal silver nanoparticles suspended in RPMI 1640 

medium at the concentration 15 mg/L. Digital micrographs of the cell nuclei in a sample of 30 

cells were created at 5 different time steps: before the treatment (controls), immediately after 

the treatment, as well as 15 minutes, 30 minutes and 60 minutes after the treatment with 

AgNPs. For each nuclear structure, values of fractal dimension, lacunarity, circularity, as well 

as parameters of grey level co-occurrence matrix (GLCM) texture, were determined. The 

results indicate time-dependent reduction of structural complexity in the cell nuclei after the 

contact with AgNPs. These findings further suggest that AgNPs, at concentrations present in 

today’s over-the-counter drug products, might have significant effects on the cell genetic 

material. 
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INTRODUCTION 

Among all nanomaterials that are today manufactured, silver nanoparticles probably 

have the highest degree of commercialization. Silver NPs are frequently incorporated into 

various consumer products such as cosmetics, paints, apparel, and household appliances. 

Silver nanomaterials are known to exhibit strong antimicrobial properties (Kim et al., 2007), 

partially because of their ability to inhibit bacterial growth. As a result, today, many 

procedures in medical and stomatological practice, such as, catheterization, dental implant 

surgery, and burn wound treatment, sometimes include application of silver NPs.  

Apart from their medical and industrial applications, silver NPs are also sometimes 

used as a nutritional mineral supplement. Colloidal silver as a suspension of Ag particles of 

approximately 0.01 micrometers in size is commercially available to general population in 

many countries. Potential health benefits of colloidal silver NPs are widely debated and there 

have been numerous studies with conflicting results and conclusions. Besides its proposed 

antimicrobial properties, it is suggested that colloidal silver also has significant antitumor 

activity, at least in cell cultures (Franco-Molina et al., 2010). On the other hand, in 1999, The 

Food and Drug Administration (USA) issued a rule about “over-the-counter drug products” 

containing colloidal silver ingredients, in which some of these consumer articles were 

misbranded due to the lack of scientific evidence regarding their safety and effectiveness.  

Exposure to silver NPs in some experimental animal models did not induce significant 

toxic effects in liver, blood, immune system, as well as in dermal tissue (van der Zande et al., 

2012; Maneewattanapinyo et al., 2011). However, in cell cultures, some authors suggested 

that silver NPs may have certain genotoxic potential (AshaRani et al., 2009; Foldbjerg et al., 

2011; Kim et al., 2011). It was assumed that silver NPs may cause disruption of the 

mitochondrial respiratory chain, and induce DNA damage through creation of reactive oxygen 

Page 3 of 28 Journal of Microscopy



For Review
 O

nly

4 

 

species (ROS). On the other hand, a recent study did not find evidence of silver NP toxic 

potential on a bacterial model (Nam et al., 2012).  

Many issues regarding potential toxicity of silver NPs on human organism to this date 

remain unresolved. Nanoparticles in general, due to their small size, can sometimes easily 

pass through both cell membrane and nuclear envelope and reach genetic material of the cell. 

When nanomaterials are administrated to a living organism, their bioavailability, deposition, 

distribution, and elimination may not adhere to the same physical/chemical principles as the 

case with the majority of medications. Similarly, in cell cultures, interaction between 

nanoparticles and individual cells and their nuclei/organelles may be significantly different 

when compared to other chemical substances. As a result, unfortunately, at present time, there 

is a lack of consensus regarding the method that could be used as gold standard for NP 

toxicity evaluation (García et al., 2011; Harper et al., 2011).  

In this study, we present the results that colloidal silver nanoparticles affect some 

complexity features of the buccal cell nuclei in a time-dependent manner. These findings may 

indicate that commercially available silver nanomaterials may have significant in vitro 

modulatory effects on the cell genetic material. 

MATERIALS AND METHODS 

Experimental protocol 

Human buccal cells obtained from a healthy individual were plated in special tissue 

culture chamber / slides (Lab-Tek, Naperville, Illinois, USA) and were kept at 37 0C in an 

RPMI 1640 cell culture medium supplemented with L-glutamine (SERVA Feinbiochemica, 

Heidelberg, Germany). The images of culture chamber / slides used in the experiment are 

provided as supplementary material (Figure 1- Supplementary Data).  
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The cells were treated with colloidal silver nanoparticles (size 7-20 nm) suspended in 

RPMI 1640 medium at the concentration 15 mg/L. Digital micrographs (magnification 400x, 

size 1280 x 1024), of buccal epithelial cell nuclei were obtained using Pro-MicroScan DEM 

200 instrument (Oplenic Optronics, Hangzhou, CN), mounted on the American Optical 

Spencer 1036A microscope (Buffalo, NY, USA) (figure 1). The micrographs of cell nuclei in 

a sample of 30 cells were created at 5 different time steps: before the treatment (controls), 

immediately after the treatment, as well as 15 minutes, 30 minutes and 60 minutes after the 

treatment with silver NPs. In this way, a total of 150 nuclear structures was visualized and 

analyzed. 

Fractal analysis 

 Fractal analysis was performed using ImageJ software (National Institutes of Health, 

USA) and the plugin FracLac (Version 2.5, Release 1e; developed by A. Karperien, Charles 

Sturt University, Australia) (Karperien, 1999-2007). Segmentation of cell nuclei was done 

similarly as in our previous studies (Pantic et al., 2013; Pantic et al., 2012a). During the 

fractal analysis, segmented nuclei were automatically converted into binary format (black and 

white image) by using the following protocol/setting: ImageJ> Plugins> Fractal analysis> 

FracLac_2.5 Release 1e> Standard box count> Auto Threshold to Binary (figure 2). For each 

nucleus, values of fractal dimension and lacunarity were determined using the standard box-

counting method. In this method, a grid of boxes is superimposed over the binary image, and 

the number of nonempty boxes (N) for different scale (ε), that at least partially cover the 

object is determined.  

 Fractal dimension (D) was calculated based on the slope of the regression line from 

the logarithmic relationship between the box count and the scale: 

D= regression slope [ ln N / ln ε ] 
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Fractal dimension is the most important indicator of structural complexity of the analyzed 

object. In biomedical research it has so far been successfully applied to quantify structural 

properties of various tissues and organs, such as liver, lungs, brain, and kidney (Canals et al., 

2000; Dioguardi et al., 2006; King et al., 2010; Milosevic et al., 2007; Pantic et al., 2013). In 

cell biology fractal dimension of nuclear structure was shown to be a sensitive parameter in 

evaluation of early stages of programmed cell death (Castelli & Losa, 2001). 

 Lacunarity (Λ) of the nuclear structures was calculated based on a coefficient of 

variation (CV) of pixels per box of size ε and orientation g: 

Λ= CV
2

ε,g=(σ⁄µ)
2

ε,g 

where µ is the pixel mean, and σ is the standard deviation after the binarization. Lacunarity is 

an important indicator of heterogeneity, and is directly related to the number and size of 

structural gaps (“gappiness”) within the analyzed object (Gilmore et al., 2009). 

Textural analysis 

Textural analysis of the nuclear structures was performed using the Grey level co-

occurrence matrix (GLCM) method (Haralick R, 1973; Pantic et al., 2012b; Alvarenga et al., 

2007; Pantic et al., 2013). For each nucleus, three GLCM parameters were determined: 

entropy (ENT), angular second moment (ASM), and inverse difference moment (IDM). These 

textural features were calculated on 8-bit micrographs using the MATLAB code (MathWorks, 

Natick, Massachusetts, USA) and ImageJ software plugins: Texture Analyzer (Cabrera, 2005) 

and GLCM_TextureToo (Cornish, 2007). 

In the original work of Haralick et al. the values of entropy, angular second moment, 

and inverse difference moment are calculated using the following formulas: 
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ENT=-�� p	�i, j� log ( p(i,j))

ji

 

ASM=���p	�i, j��2
ji

 

IDM =�� 1

1+�i-j�2

ji

 p(i,j) 

where i and j are coordinates of the co-occurrence matrix. 

Angular second moment was determined as a measure of textural uniformity (Sharma 

et al., 2008). An object with higher degree of structural variations is expected to produce 

lower value of ASM. Entropy is a parameter of disorder of resolution units in a micrograph 

(Pantic et al., 2012b; Pantic et al., 2012c). A nucleus with high level of structural 

disorganization will have increased ENT. Inverse difference moment on the other hand is a 

measure of local homogeneity (Sharma et al., 2008). 

Circularity of the nuclear envelope 

As an addition to the fractal and textural analysis, for each individual cell (at each 

step) circularity of the nuclear envelope was determined. Circularity (f) is calculated as a 

function of the nuclear area (A) and perimeter (P) using the formula: 

� � 4
�
�
  

Circularity was determined using the following protocol: ImageJ>Analyze>Set 

Measurements>Shape Descriptors; ImageJ>Analyze>Measure. When circularity equals 1, the 

Page 7 of 28 Journal of Microscopy



For Review
 O

nly

8 

 

shape of the analyzed nucleus (when regarded as a two-dimensional object) resembles a 

perfect circle.  

Inter-observer reliability of fractal and textural analysis 

 Inter-observer reliability, as a quality assurance of the methods used in this study, was 

determined similarly as in our recently published work (Pantic et al., 2013). Briefly, a sample 

of 100 randomly selected nuclei was analyzed blindly by two researchers. Pearson product-

moment correlation coefficient was determined between the two data sets. 

Statistical analysis 

Statistical analysis was carried out in SPSS statistical software (IBM Corporation, 

Chicago, IL), using ANOVA test for determining the significance of difference between the 5 

independent samples taken at 5 time steps. Post hoc analysis was done using Dunnett’s  where 

the first time step (nuclei before the treatment with silver NPs) served as the comparator. 

Correlation between the fractal / textural parameters was tested using Pearson product-

moment correlation coefficient or Spearman's rank correlation coefficient depending on the 

normality of distribution (determined by Kolmogorov–Smirnov test). 

RESULTS 

Fractal analysis 

 Average value of nuclear fractal dimension in control group of cells was 1.522±0.057. 

Immediately after the treatment there was a statistically significant reduction of D 

(D0min=1.477±0.047, p<0.05). Fractal dimension continued to decrease in subsequent time 

points (D15min= 1.457±0.048, p<0.01; D30min= 1.442±0.071, p<0.01, compared with control), 

and it reached its minimal value 60 minutes after the treatment with silver NPs 
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(D60min=1.434±0.063, p<0.01). Nuclear fractal values and standard deviations in different cell 

groups are presented in figure 3. There was a statistically significant negative trend for D in 

the observed time points (ptrend<0.01). These results indicate a generalized and time-dependent  

complexity reduction of nuclear architecture after nanoparticle treatment.   

 Average nuclear lacunarity before the silver NP treatment was 0.987±0.283. 

Immediately after the treatment, lacunarity increased (Λ0min=1.141±0.224), however the 

change was not statistically significant. Lacunarity continued to increase in subsequent time 

points. 15 and 30 minutes after the treatment the difference was statistically significant 

(Λ15min=1.349 ±0.495, Λ30min=1.385±0.558, p<0.01), compared with control. Lacunarity 

reached its maximal value 60 minutes after the treatment (Λ60min=1.409±0.516, p<0.01). There 

was a statistically significant positive trend for Λ in the observed time points (ptrend<0.01, 

figure 4). 

 Statistically significant negative correlation was detected between nuclear fractal 

dimension and lacunarity in all time points. The strongest relationship was observed 

immediately after the treatment (R0min= -0.71, p<0.01), while the weakest correlation was 

present 60 minutes after the nanoparticle administration (R60min= -0.51, p<0.01). The plotted 

values of fractal dimension and lacunarity for each cell group are presented in figure 5. Figure 

6 shows the range of variation of fractal dimension and lacunarity values for each time step.  

The decreasing fractal dimension corresponded to the increasing values of lacunarity. The 

values of Pearson’s correlation coefficient for inter-observer agreement were 0.98 for fractal 

dimension and 0.96 for lacunarity.  
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Textural analysis 

 Average values of nuclear GLCM parameters with standard deviations are presented in 

table 1. The values of entropy, angular second moment, and inverse difference moment did 

not significantly change after the NP treatment. Trend analysis also showed no statistical 

significance (ptrend>0.05). There was no significant correlation between GLCM and fractal 

parameters. 

 The values of Pearson’s correlation coefficient for inter-observer agreement for all 

three GLCM parameters were approximately 0.98, suggesting that textural, similarly as fractal 

analysis is a method with potentially high reproducibility.  

Circularity analysis 

 The average circularity of nuclear envelope before the treatment was 0.85±0.07. 

Immediately after the NP administration the value increased to 0.87±0.05, however, the 

difference was not statistically significant (p>0.05). In subsequent time points circularity also 

did not significantly change (f15min= 0.85±0.09; f30min= 0.83±0.10; f60min= 0.86±0.08; p>0.05). 

Circularity did not correlate with the values of fractal dimension and lacunarity, indicating 

that the roughness (and probably the complexity) of nuclear envelope did not impact the 

overall complexity of the cell nucleus in any time point. 

DISCUSSION 

 Our results indicate that silver nanoparticles affect nuclear fractal properties in isolated 

human epithelial buccal cells in a time-dependent manner. These findings suggest that silver 

NPs have substantial modulatory effects on genetic material in normal human cells. To our 

knowledge, this is the first study to investigate potential changes in complexity of a cell 

nucleus after treatment with nanomaterials. 
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 The nanoparticle concentration (15 mg/l) used in this experiment is similar to the ones 

used in commercial over-the-counter drug products containing colloidal silver NPs. These 

products are today predominantly sold as dietary supplements (lower concentrations such as 

5-15 mg/L) or as remedies for mild skin and/or mucosal lesions (higher concentrations). The 

effectiveness and potential toxicity of many of these products are generally unclear. Recent 

studies have suggested that similar AgNP concentrations could have some cytotoxic effects 

on isolated epithelial cells (Mukherjee et al., 2012). In in vivo conditions, it has been reported 

that 15 mg/l (considered as “low concentration”) of AgNPs may have potential antiparasitic 

properties (Chauke & Siebrits, 2012).  

  It is known that DNA molecule and chromatin as a higher level of DNA organization 

exhibit fractal characteristics in their ultrastructure (Cattani, 2012a; Cattani, 2012b; Bancaud 

et al., 2009). Fractal model of nucleoplasm architecture, based on approximately 100 nm 

fractal domains, was suggested by recent study, having in mind the specific chromatin 

diffusion properties (Bancaud et al., 2009; Bancaud et al., 2012). The diffusion and 

distribution characteristics of some nanoparticles such as quantum dots is consistent with this 

proposed fractal organization. Moreover, it was shown that transcriptionally more active 

euchromatin has higher value of fractal dimension than heterochromatin.  

 There have been several efforts to explain the suggested higher values of fractal 

dimension in euchromatin when compared to heterochromatin. It is known that 

heterochromatin has significantly more compact and smoother architecture than euchromatin 

(Bancaud et al., 2012). Rough structures, when analyzed as two-dimensional (as the case in 

our study), or three-dimensional signals, generally tend to have higher degree of complexity 

which impacts the values of fractal dimension.  
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It is possible that the time-dependent reduction of nuclear complexity detected in our 

study was a result of the changed euchromatin / heterochromatin ratio in buccal cells after 

treatment with silver NPs. The increased proportion of heterochromatin would lead to 

“smoothening” of the nuclear structures when observed using optical microscopy.  Since 

heterochromatin is less transcriptionally active, this would further indicate that silver NPs 

affect the transcription rate in the cell nucleus through some unknown signaling pathway. 

However, this hypothesis has to be approached with caution, since the nuclear structures in 

our study were analyzed without using any histological dyes.  It is also possible that detected 

changes in nuclear complexity might have been the result of specific intersections between 

NPs and some chromatin (i.e. non-histone) proteins in nucleoplasm, rather than changes in 

DNA structure and gene expression.   

 There is also a possibility that fractal and textural analysis were able to detect the 

potential genotoxicity effects induced by silver NPs. Although silver NP genotoxicity has so 

far been the subject of many studies, sometimes with inconclusive and even conflicting 

results, it is clear that these particles, due to their small size can easily reach many if not all 

cell compartments, including the nucleus, and freely interact with DNA. There is some 

evidence that silver NPs in lymphocytes exhibit their genotoxic potential indirectly through 

generation of reactive oxygen species (determined with flow cytometry method) (Ghosh et al., 

2012). Also, in lymphocyte culture, it was suggested that silver NPs may increase the level of 

DNA strand breaks which can be measured using the single cell gel electrophoresis assay 

(Comet assay) (Ghosh et al., 2012). We could speculate that in our study the damaged DNA 

after treatment significantly decreased the complexity of buccal cell nucleoplasm which was 

then manifested through the lowered values of nuclear fractal dimension.  

 It has been suggested that fractal analysis of nuclear ultrastructure may be a sensitive 

method for detection of early stages of programmed cell death (apoptosis) (Castelli & Losa, 
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2001). The sensitivity of both fractal and some grey level co-occurrence matrix parameters 

may in some cases even be greater than of conventional cytofluorometric methods. Processes 

that take place in the cell DNA during early stages of apoptosis may be followed by 

generalized reduction of complexity in nuclear components (Castelli & Losa, 2001; Losa & 

Castelli, 2005). Fractal dimension of some chromatin domains such as heterochromatin 

outline can significantly decrease after treatment with the pro-apoptotic substance from the 

initial value of approximately 1.6 to 1.4 (Losa & Castelli, 2005). The absolute fractal 

dimension values for some chromatin domains obtained by Losa & Castelli (2005) are similar 

to the values of nuclear fractal dimension in our research, however one should have in mind 

that the absolute value of fractal parameters is largely influenced by methodological and 

technical issues such as magnification (optical or electron microscopy), selection of 

histological dyes etc. It is possible that the time-dependent loss of nuclear complexity 

detected in our study was at least partially caused by nuclear events that precede programmed 

cell death, such as condensation and marginalization of chromatin. This observation would be 

in accordance with the findings of other authors showing that silver NPs in certain cells have 

significant proapototic potential determined through conventional molecular biology methods 

(Eom & Choi, 2010; Singh & Ramarao, 2012).  

Mukherjee et al (2012) suggested that AgNPs in similar and larger concentrations as 

the one used in our study may cause elevated levels of oxidative stress products, reduction of 

glutathione concentration and the cell membrane damage in cell culture (Mukherjee et al., 

2012). All these factors may increase the probability of programmed cell death. In the 

mentioned work, the authors performed standard cytotoxicity tests such as Alamar Blue, 

Neutral Red, MTT assay, and Coomassie Blue assay. A bioluminescent method which 

measures the intracellular ADP/ATP ratio was applied for apoptosis evaluation (Mukherjee et 

al., 2012). The readings were noted and evaluated 24h, 48h and 72h after NP exposure. If 
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these results are confirmed in the future, it may be assumed that fractal analysis is capable of 

detecting AgNP-induced cell toxicity much earlier than conventional methods.     

 In our previous study focused on structural complexity of nuclear chromatin in kidney 

macula densa cells, we found similar changes in fractal dimension and lacunarity that were 

related to aging process (Pantic et al., 2013).  In a mouse experimental model, it was shown 

that, in older animals, chromatin complexity decreases, while chromatin textural parameters 

(angular second moment and inverse difference moment) do not change significantly. We 

may assume that the same intrinsic factors (epigenetic chromatin dysregulation, DNA 

damage) that influence nuclear complexity in aging, might have also been present in our in 

vitro model of buccal cells after NP treatment. However, additional research is needed to 

confirm this assumption. 

 One of the advantages of fractal and textural analysis as methods for evaluation of NP 

genomodulatory effects, apart from their suggested high sensitivity in apoptosis detection, is 

the fact that these techniques are relatively exact.  In our study, we performed the evaluation 

of inter-observer agreement for all measured fractal and textural features. The high values of 

Pearson’s coefficient that were obtained as the result, indicate that both methods might have a 

high degree of reproducibility. In the future, if this quality assurance evaluation is confirmed 

by other studies, these parameters could become an important addition to contemporary cell 

biology methods for NP toxicity testing. 

 The results of our research may also have certain clinical and public health 

implications. The concentration of silver NPs used in the experiment (15 mg/L) is similar to 

the NP concentrations in most today’s commercially available “over-the-counter drug 

products” containing colloidal silver. Furthermore, this is the first study to investigate the 

potential NP effects on isolated normal buccal epithelial cells. These cells are probably the 
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first that come into contact with colloidal silver products used as dietary supplements. The 

effective concentration of silver NPs in other tissues and organs is much lower when 

compared with buccal mucosa.   

 In a future study, perhaps, it would be interesting to investigate whether silver 

nanomaterials have the same effects on the nuclear structural complexity in stained cell/tissue 

specimens. By applying specific, DNA-binding histological dyes, such as the one used in 

Feulgen staining technique, we could be able to analyze specific changes in DNA complexity, 

rather than complexity of the cell nucleus as a whole. This approach might give us better 

understanding of the precise mechanisms of silver NP interaction with cell genetic material. 

 In conclusion, our results indicate that silver nanoparticles, at concentrations present in 

today’s over-the-counter drug products affect nuclear complexity of buccal epithelial cells in 

a time-dependent manner. These findings suggest that commercially available silver 

nanomaterials might have substantial genetic modulatory effects in human epithelial cells. 
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Figure Captions 

Figure 1. Example of a digital micrograph of  buccal epithelial cell (with visible nucleus) 

plated in the culture chamber / slide (Magnification 400x, acquired by Pro-MicroScan DEM 

200 instrument; Scale bar provided). 

Figure 2. Example of 4 segmented cell nuclei (control group). Before the fractal analysis, the 

nuclei were automatically converted into binary format. 

Figure 3. Fractal dimension of nuclear structures before the treatment with silver NPs 

(Control), immediately after the treatment (0 min), and subsequent time points. *p<0.01, 

compared to control. 

Figure 4. Lacunarity of nuclear structures before the treatment with silver NPs (Control), 

immediately after the treatment (0 min), and subsequent time points. *p<0.01, compared to 

control. 

Figure 5. Plotted values of nuclear fractal dimension and lacunarity for the 30 cell nuclei 

before the silver NP treatment (A), immediately after the treatment (B), 15 min (C), 30 min 

(D) and 60 min (E) after the treatment. 

Figure 6. Time evolution of variation ranges of fractal dimension (D) and lacunarity (L) in 

nuclear structures after the treatment with silver NPs. 

Supplementary Data 

Figure 1 (Supplementary Data). Image of a culture chamber / slides used in the experiment. 
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 Angular second 

moment 

Entropy Inverse difference 

moment 

Control 0.072±0.041 5.631±0.461 0.509±0.053 

0 min 0.060±0.018 5.657±0.323 0.513±0.039 

15 min 0.068±0.032 5.678±0.406 0.505±0.047 

30 min 0.079±0.055 5.565±0.507 0.518±0.054 

60 min 0.063±0.036 5.673±0.420 0.507±0.047 

 

Table 1. Average values of nuclear GLCM parameters in different time points. 
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Figure 1. Example of a digital micrograph of  buccal epithelial cell (with visible nucleus) plated in the culture 
chamber / slide (Magnification 400x, acquired by Pro-MicroScan DEM 200 instrument; Scale bar provided).  
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Figure 2. Example of 4 segmented cell nuclei (control group). Before the fractal analysis, the nuclei were 
automatically converted into binary format.  
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Figure 3. Fractal dimension of nuclear structures before the treatment with silver NPs (Control), immediately 
after the treatment (0 min), and subsequent time points. *p<0.01, compared to control.  
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Figure 4. Lacunarity of nuclear structures before the treatment with silver NPs (Control), immediately after 
the treatment (0 min), and subsequent time points. *p<0.01, compared to control.  
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Figure 5. Plotted values of nuclear fractal dimension and lacunarity for the 30 cell nuclei before the silver NP 
treatment (A), immediately after the treatment (B), 15 min (C), 30 min (D) and 60 min (E) after the 

treatment.  
529x500mm (72 x 72 DPI)  
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Figure 6. Time evolution of variation ranges of fractal dimension (D) and lacunarity (L) in nuclear structures 
after the treatment with silver NPs.  
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